
4. In Data Analysis, select Histogram and click the [OK] button.

5. In the Histogram dialog box, type A1:A50 as the Input Range.

6. Select New Worksheet Ply, and check the Cumulative Percentage option. Click [OK].

By leaving the Chart output unchecked, the new worksheet will display the table only. It
decides “bins” for the histogram itself (here it picked a bin size of 7 units), but you can also
define your own bin range on the data worksheet.
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2–3 Histograms, Frequency Polygons, and Ogives
After the data have been organized into a frequency distribution, they can be presented
in graphical form. The purpose of graphs in statistics is to convey the data to the viewers
in pictorial form. It is easier for most people to comprehend the meaning of data pre-
sented graphically than data presented numerically in tables or frequency distributions.
This is especially true if the users have little or no statistical knowledge.

Statistical graphs can be used to describe the data set or to analyze it. Graphs are also
useful in getting the audience’s attention in a publication or a speaking presentation. They
can be used to discuss an issue, reinforce a critical point, or summarize a data set. They
can also be used to discover a trend or pattern in a situation over a period of time.

The three most commonly used graphs in research are as follows:

1. The histogram.

2. The frequency polygon.

3. The cumulative frequency graph, or ogive (pronounced o-jive).

An example of each type of graph is shown in Figure 2–1. The data for each graph are
the distribution of the miles that 20 randomly selected runners ran during a given week.

The Histogram

The histogram is a graph that displays the data by using contiguous vertical bars
(unless the frequency of a class is 0) of various heights to represent the frequencies of
the classes.

Objective 

Represent data
in frequency
distributions
graphically using
histograms, frequency
polygons, and ogives.

2

Example 2–4 Construct a histogram to represent the data shown for the record high temperatures for
each of the 50 states (see Example 2–2).

Class boundaries Frequency

99.5–104.5 2
104.5–109.5 8
109.5–114.5 18
114.5–119.5 13
119.5–124.5 7
124.5–129.5 1
129.5–134.5 1

Solution

Step 1 Draw and label the x and y axes. The x axis is always the horizontal axis, and
the y axis is always the vertical axis.
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Class boundaries
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Examples of
Commonly Used
Graphs



Step 2 Represent the frequency on the y axis and the class boundaries on the x axis.

Step 3 Using the frequencies as the heights, draw vertical bars for each class. See
Figure 2–2.

As the histogram shows, the class with the greatest number of data values (18) is
109.5–114.5, followed by 13 for 114.5–119.5. The graph also has one peak with the
data clustering around it.

The Frequency Polygon
Another way to represent the same data set is by using a frequency polygon.

The frequency polygon is a graph that displays the data by using lines that connect
points plotted for the frequencies at the midpoints of the classes. The frequencies are
represented by the heights of the points.

Example 2–5 shows the procedure for constructing a frequency polygon.
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Histogram for
Example 2–4

Historical Note

Graphs originated
when ancient
astronomers drew the
position of the stars in
the heavens. Roman
surveyors also used
coordinates to locate
landmarks on their
maps.

The development
of statistical graphs
can be traced to
William Playfair
(1748–1819), an
engineer and drafter
who used graphs to
present economic
data pictorially.

Example 2–5 Using the frequency distribution given in Example 2–4, construct a frequency polygon.

Solution

Step 1 Find the midpoints of each class. Recall that midpoints are found by adding
the upper and lower boundaries and dividing by 2:

and so on. The midpoints are

Class boundaries Midpoints Frequency

99.5–104.5 102 2
104.5–109.5 107 8
109.5–114.5 112 18
114.5–119.5 117 13
119.5–124.5 122 7
124.5–129.5 127 1
129.5–134.5 132 1

99.5 � 104.5
2

� 102    104.5 � 109.5
2

� 107



Step 2 Draw the x and y axes. Label the x axis with the midpoint of each class, and
then use a suitable scale on the y axis for the frequencies.

Step 3 Using the midpoints for the x values and the frequencies as the y values, plot
the points.

Step 4 Connect adjacent points with line segments. Draw a line back to the x axis at
the beginning and end of the graph, at the same distance that the previous and
next midpoints would be located, as shown in Figure 2–3.

The frequency polygon and the histogram are two different ways to represent the
same data set. The choice of which one to use is left to the discretion of the researcher.

The Ogive
The third type of graph that can be used represents the cumulative frequencies for
the classes. This type of graph is called the cumulative frequency graph or ogive. The
cumulative frequency is the sum of the frequencies accumulated up to the upper bound-
ary of a class in the distribution.

The ogive is a graph that represents the cumulative frequencies for the classes in a
frequency distribution.

Example 2–6 shows the procedure for constructing an ogive.
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Figure 2–3

Frequency Polygon for
Example 2–5
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Example 2–6 Construct an ogive for the frequency distribution described in Example 2–4.

Solution

Step 1 Find the cumulative frequency for each class.

Class boundaries Cumulative frequency

99.5–104.5 2
104.5–109.5 10
109.5–114.5 28
114.5–119.5 41
119.5–124.5 48
124.5–129.5 49
129.5–134.5 50



Step 2 Draw the x and y axes. Label the x axis with the class boundaries. Use an
appropriate scale for the y axis to represent the cumulative frequencies.
(Depending on the numbers in the cumulative frequency columns, scales such
as 0, 1, 2, 3, . . . , or 5, 10, 15, 20, . . . , or 1000, 2000, 3000, . . . can be used.
Do not label the y axis with the numbers in the cumulative frequency
column.) In this example, a scale of 0, 5, 10, 15, . . . will be used.

Step 3 Plot the cumulative frequency at each upper class boundary, as shown in
Figure 2–4. Upper boundaries are used since the cumulative frequencies
represent the number of data values accumulated up to the upper boundary
of each class.

Step 4 Starting with the first upper class boundary, 104.5, connect adjacent points
with line segments, as shown in Figure 2–5. Then extend the graph to the first
lower class boundary, 99.5, on the x axis.

Cumulative frequency graphs are used to visually represent how many values are
below a certain upper class boundary. For example, to find out how many record high
temperatures are less than 114.5�F, locate 114.5�F on the x axis, draw a vertical line up
until it intersects the graph, and then draw a horizontal line at that point to the y axis. The
y axis value is 28, as shown in Figure 2–6.
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Plotting the Cumulative
Frequency for
Example 2–6
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Relative Frequency Graphs
The histogram, the frequency polygon, and the ogive shown previously were constructed
by using frequencies in terms of the raw data. These distributions can be converted to dis-
tributions using proportions instead of raw data as frequencies. These types of graphs are
called relative frequency graphs.

Graphs of relative frequencies instead of frequencies are used when the proportion
of data values that fall into a given class is more important than the actual number of data
values that fall into that class. For example, if one wanted to compare the age distribu-
tion of adults in Philadelphia, Pennsylvania, with the age distribution of adults of Erie,
Pennsylvania, one would use relative frequency distributions. The reason is that since the
population of Philadelphia is 1,478,002 and the population of Erie is 105,270, the bars
using the actual data values for Philadelphia would be much taller than those for the same
classes for Erie.

To convert a frequency into a proportion or relative frequency, divide the frequency
for each class by the total of the frequencies. The sum of the relative frequencies will
always be 1. These graphs are similar to the ones that use raw data as frequencies, but the
values on the y axis are in terms of proportions. Example 2–7 shows the three types of
relative frequency graphs.
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Figure 2–6

Finding a Specific
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Procedure Table

Constructing Statistical Graphs
Step 1 Draw and label the x and y axes.

Step 2 Choose a suitable scale for the frequencies or cumulative frequencies, and label it
on the y axis.

Step 3 Represent the class boundaries for the histogram or ogive, or the midpoint for the
frequency polygon, on the x axis.

Step 4 Plot the points and then draw the bars or lines.

Unusual Stat

Twenty-two percent
of Americans sleep
6 hours a day or fewer.

The steps for drawing these three types of graphs are shown in the following
Procedure Table.



54 Chapter 2 Frequency Distributions and Graphs

2–22

Example 2–7 Construct a histogram, frequency polygon, and ogive using relative frequencies for the
distribution (shown here) of the miles that 20 randomly selected runners ran during a
given week.

Class Cumulative 
boundaries Frequency frequency

5.5–10.5 1 1
10.5–15.5 2 3
15.5–20.5 3 6
20.5–25.5 5 11
25.5–30.5 4 15
30.5–35.5 3 18
35.5–40.5 2 20

20

Solution

Step 1 Convert each frequency to a proportion or relative frequency by dividing the
frequency for each class by the total number of observations.

For class 5.5–10.5, the relative frequency is � 0.05; for class 10.5–15.5,
the relative frequency is � 0.10; for class 15.5–20.5, the relative frequency
is � 0.15; and so on.

Place these values in the column labeled Relative frequency.

Step 2 Find the cumulative relative frequencies. To do this, add the frequency in each
class to the total frequency of the preceding class. In this case, 0 � 0.05 �
0.05, 0.05 � 0.10 � 0.15, 0.15 � 0.15 � 0.30, 0.30 � 0.25 � 0.55, etc. Place
these values in the column labeled Cumulative relative frequency.

Using the same procedure, find the relative frequencies for the Cumulative
frequency column. The relative frequencies are shown here.

Cumulative
Class Relative relative 

boundaries Midpoints frequency frequency

5.5–10.5 8 0.05 0.05
10.5–15.5 13 0.10 0.15
15.5–20.5 18 0.15 0.30
20.5–25.5 23 0.25 0.55
25.5–30.5 28 0.20 0.75
30.5–35.5 33 0.15 0.90
35.5–40.5 38 0.10 1.00

1.00

Step 3 Draw each graph as shown in Figure 2–7. For the histogram and ogive,
use the class boundaries along the x axis. For the frequency polygon, 
use the midpoints on the x axis. The scale on the y axis uses 
proportions.

3
20

2
20

1
20



Distribution Shapes
When one is describing data, it is important to be able to recognize the shapes of the dis-
tribution values. In later chapters you will see that the shape of a distribution also deter-
mines the appropriate statistical methods used to analyze the data.
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A distribution can have many shapes, and one method of analyzing a distribution is
to draw a histogram or frequency polygon for the distribution. Several of the most com-
mon shapes are shown in Figure 2–8: the bell-shaped or mound-shaped, the uniform-
shaped, the J-shaped, the reverse J-shaped, the positively or right-skewed shaped, the
negatively or left-skewed shaped, the bimodal-shaped, and the U-shaped.

Distributions are most often not perfectly shaped, so it is not necessary to have an
exact shape but rather to identify an overall pattern.

A bell-shaped distribution shown in Figure 2–8(a) has a single peak and tapers off
at either end. It is approximately symmetric; i.e., it is roughly the same on both sides of
a line running through the center.

A uniform distribution is basically flat or rectangular. See Figure 2–8(b).
A J-shaped distribution is shown in Figure 2–8(c), and it has a few data values on

the left side and increases as one moves to the right. A reverse J-shaped distribution is
the opposite of the J-shaped distribution. See Figure 2–8(d).
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When the peak of a distribution is to the left and the data values taper off to the
right, a distribution is said to be positively or right-skewed. See Figure 2–8(e). When
the data values are clustered to the right and taper off to the left, a distribution is said to
be negatively or left-skewed. See Figure 2–8(f). Skewness will be explained in detail
in Chapter 3, pages 108–109. Distributions with one peak, such as those shown in
Figure 2–8(a), (e), and (f), are said to be unimodal. (The highest peak of a distribution
indicates where the mode of the data values is. The mode is the data value that occurs
more often than any other data value. Modes are explained in Chapter 3.) When a distri-
bution has two peaks of the same height, it is said to be bimodal. See Figure 2–8(g).
Finally, the graph shown in Figure 2–8(h) is a U-shaped distribution.

Distributions can have other shapes in addition to the ones shown here; however,
these are some of the more common ones that you will encounter in analyzing data.

When you are analyzing histograms and frequency polygons, look at the shape of the
curve. For example, does it have one peak or two peaks? Is it relatively flat, or is it
U-shaped? Are the data values spread out on the graph, or are they clustered around
the center? Are there data values in the extreme ends? These may be outliers. (See
Section 3–4 for an explanation of outliers.) Are there any gaps in the histogram, or does
the frequency polygon touch the x axis somewhere other than the ends? Finally, are the
data clustered at one end or the other, indicating a skewed distribution?

For example, the histogram for the record high temperatures shown in Figure 2–2
shows a single peaked distribution, with the class 109.5–114.5 containing the largest
number of temperatures. The distribution has no gaps, and there are fewer temperatures
in the highest class than in the lowest class.

Applying the Concepts 2–3

Selling Real Estate
Assume you are a realtor in Bradenton, Florida. You have recently obtained a listing of the
selling prices of the homes that have sold in that area in the last 6 months. You wish to
organize that data so you will be able to provide potential buyers with useful information.
Use the following data to create a histogram, frequency polygon, and cumulative frequency
polygon.

142,000 127,000 99,600 162,000 89,000 93,000 99,500
73,800 135,000 119,500 67,900 156,300 104,500 108,650

123,000 91,000 205,000 110,000 156,300 104,000 133,900
179,000 112,000 147,000 321,550 87,900 88,400 180,000
159,400 205,300 144,400 163,000 96,000 81,000 131,000
114,000 119,600 93,000 123,000 187,000 96,000 80,000
231,000 189,500 177,600 83,400 77,000 132,300 166,000

1. What questions could be answered more easily by looking at the histogram rather than the
listing of home prices?

2. What different questions could be answered more easily by looking at the frequency
polygon rather than the listing of home prices?

3. What different questions could be answered more easily by looking at the cumulative
frequency polygon rather than the listing of home prices?

4. Are there any extremely large or extremely small data values compared to the other data
values?

5. Which graph displays these extremes the best?

6. Is the distribution skewed? 

See page 93 for the answers.
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1. For 108 randomly selected college applicants, the
following frequency distribution for entrance exam
scores was obtained. Construct a histogram,
frequency polygon, and ogive for the data. (The
data for this exercise will be used for Exercise 13
in this section.)

Class limits Frequency

90–98 6
99–107 22

108–116 43
117–125 28
126–134 9

Applicants who score above 107 need not enroll
in a summer developmental program. In this group,
how many students do not have to enroll in the
developmental program?

2. For 75 employees of a large department store, the
following distribution for years of service was obtained.
Construct a histogram, frequency polygon, and ogive
for the data. (The data for this exercise will be used for
Exercise 14 in this section.)

Class limits Frequency

1–5 21
6–10 25

11–15 15
16–20 0
21–25 8
26–30 6

A majority of the employees have worked for how
many years or less?

3. The scores for the 2002 LPGA—Giant Eagle are shown.

Score Frequency

202–204 2
205–207 7
208–210 16
211–213 26
214–216 18
217–219 4
Source: LPGA.com.

Construct a histogram, frequency polygon, and
ogive for the distribution. Comment on the skewness of
the distribution.

4. The salaries (in millions of dollars) for 31 NFL
teams for a specific season are given in this frequency
distribution.

Class limits Frequency

39.9–42.8 2
42.9–45.8 2
45.9–48.8 5
48.9–51.8 5
51.9–54.8 12
54.9–57.8 5

Source: NFL.com.

Construct a histogram, frequency polygon, and
ogive for the data; and comment on the shape of the
distribution.

5. Thirty automobiles were tested for fuel efficiency,
in miles per gallon (mpg). The following frequency
distribution was obtained. Construct a histogram,
frequency polygon, and ogive for the data.

Class boundaries Frequency

7.5–12.5 3
12.5–17.5 5
17.5–22.5 15
22.5–27.5 5
27.5–32.5 2

6. Construct a histogram, frequency polygon, and ogive
for the data in Exercise 14 in Section 2–2, and analyze
the results.

7. The air quality measured for selected cities in the
United States for 1993 and 2002 is shown. The data are
the number of days per year that the cities failed to meet
acceptable standards. Construct a histogram for both
years and see if there are any notable changes. If so,
explain. (The data in this exercise will be used for
Exercise 17 in this section.)

1993 2002

Class Frequency Class Frequency

0–27 20 0–27 19
28–55 4 28–55 6
56–83 3 56–83 2
84–111 1 84–111 0

112–139 1 112–139 0
140–167 0 140–167 3
168–195 1 168–195 0
Source: World Almanac and Book of Facts.

8. In a study of reaction times of dogs to a specific
stimulus, an animal trainer obtained the following data,
given in seconds. Construct a histogram, frequency
polygon, and ogive for the data, and analyze the results.

Exercises 2–3



(The histogram in this exercise will be used for
Exercise 18 in this section, Exercise 16 in Section 3–2,
and Exercise 26 in Section 3–3.)

Class limits Frequency

2.3–2.9 10
3.0–3.6 12
3.7–4.3 6
4.4–5.0 8
5.1–5.7 4
5.8–6.4 2

9. Construct a histogram, frequency polygon, and ogive
for the data in Exercise 15 of Section 2–2, and analyze
the results.

10. The frequency distributions shown indicate the
percentages of public school students in fourth-grade
reading and mathematics who performed at or above
the required proficiency levels for the 50 states in the
United States. Draw histograms for each and decide if
there is any difference in the performance of the
students in the subjects.

Reading Math 
Class Frequency Frequency

17.5–22.5 7 5
22.5–27.5 6 9
27.5–32.5 14 11
32.5–37.5 19 16
37.5–42.5 3 8
42.5–47.5 1 1
Source: National Center for Educational Statistics.

11. Construct a histogram, frequency polygon, and ogive
for the data in Exercise 16 in Section 2–2, and analyze
the results.

12. For the data in Exercise 18 in Section 2–2, construct
a histogram for the home run distances for each
player and compare them. Are they basically the
same, or are there any noticeable differences?
Explain your answer.

13. For the data in Exercise 1 in this section, construct a
histogram, frequency polygon, and ogive, using relative
frequencies. What proportion of the applicants need to
enroll in the summer developmental program?

14. For the data in Exercise 2 in this section, construct a
histogram, frequency polygon, and ogive, using relative

frequencies. What proportion of the employees have
been with the store for more than 20 years?

15. The number of calories per serving for selected
ready-to-eat cereals is listed here. Construct a

frequency distribution using 7 classes. Draw a
histogram, frequency polygon, and ogive for the data,
using relative frequencies. Describe the shape of the
histogram.

130 190 140 80 100 120 220 220 110 100
210 130 100 90 210 120 200 120 180 120
190 210 120 200 130 180 260 270 100 160
190 240 80 120 90 190 200 210 190 180
115 210 110 225 190 130
Source: The Doctor’s Pocket Calorie, Fat, and Carbohydrate Counter.

16. The amount of protein (in grams) for a variety
of fast-food sandwiches is reported here. Construct

a frequency distribution using 6 classes. Draw a
histogram, frequency polygon, and ogive for the data,
using relative frequencies. Describe the shape of the
histogram.

23 30 20 27 44 26 35 20 29 29
25 15 18 27 19 22 12 26 34 15
27 35 26 43 35 14 24 12 23 31
40 35 38 57 22 42 24 21 27 33
Source: The Doctor’s Pocket Calorie, Fat, and Carbohydrate Counter.

17. For the data for year 2002 in Exercise 7 in this section,
construct a histogram, frequency polygon, and ogive,
using relative frequencies.

18. The animal trainer in Exercise 8 in this section selected
another group of dogs who were much older than the
first group and measured their reaction times to the
same stimulus. Construct a histogram, frequency
polygon, and ogive for the data.

Class limits Frequency

2.3–2.9 1
3.0–3.6 3
3.7–4.3 4
4.4–5.0 16
5.1–5.7 14
5.8–6.4 4

Analyze the results and compare the histogram for
this group with the one obtained in Exercise 8 in this
section. Are there any differences in the histograms?
(The data in this exercise will be used for Exercise 16
in Section 3–2 and Exercise 26 in Section 3–3.)
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19. Using the histogram shown here, do the following.

Class boundaries
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Extending the Concepts
a. Construct a frequency distribution; include class

limits, class frequencies, midpoints, and cumulative
frequencies.

b. Construct a frequency polygon.
c. Construct an ogive.

20. Using the results from Exercise 19, answer these
questions.

a. How many values are in the class 27.5–30.5?
b. How many values fall between 24.5 and 36.5?
c. How many values are below 33.5?
d. How many values are above 30.5?

Construct a Histogram
1. Enter the data from Example 2–2, the high temperatures for the 50 states.

2. Select Graph>Histogram.

3. Select [Simple], then click [OK].

4. Click C1 TEMPERATURES in the Graph variables dialog box.

5. Click [Labels]. There are two tabs, Title/Footnote and Data Labels.

a) Click in the box for Title, and type in Your Name and Course Section.

b) Click [OK]. The Histogram dialog box is still open.

6. Click [OK]. A new graph window 
containing the histogram will open.

7. Click the File menu to print 
or save the graph.

Technology Step by Step

MINITAB
Step by Step



8. Click File>Exit.

9. Save the project as Ch2-3.mpj.
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TI-83 Plus or
TI-84 Plus
Step by Step

Constructing a Histogram
To display the graphs on the screen, enter the appropriate values in the calculator, using the
WINDOW menu. The default values are Xmin � �10, Xmax � �10, Ymin � �10, and Ymax � �10.

The Xscl changes the distance between the tick marks on the x axis and can be used to change
the class width for the histogram.

To change the values in the WINDOW:

1. Press WINDOW.

2. Move the cursor to the value that needs to be changed. Then type in the desired value and
press ENTER.

3. Continue until all values are appropriate.

4. Press [2nd] [QUIT] to leave the WINDOW menu.

To plot the histogram from raw data:

1. Enter the data in L1.

2. Make sure WINDOW values are appropriate for the histogram.

3. Press [2nd] [STAT PLOT] ENTER.

4. Press ENTER to turn the plot on, if necessary.

5. Move cursor to the Histogram symbol and press ENTER, if necessary.

6. Make sure Xlist is L1.

7. Make sure Freq is 1.

8. Press GRAPH to display the histogram.

9. To obtain the number of data values in each class, press the TRACE key, followed by 
� or � keys.

Example TI2–1

Plot a histogram for the following data from Examples 2–2 and 2–4.

112 100 127 120 134 118 105 110 109 112
110 118 117 116 118 122 114 114 105 109
107 112 114 115 118 117 118 122 106 110
116 108 110 121 113 120 119 111 104 111
120 113 120 117 105 110 118 112 114 114

Press TRACE and use the arrow keys to determine the number of values in each group.

To graph a histogram from grouped data:

1. Enter the midpoints into L1.

2. Enter the frequencies into L2.

3. Make sure WINDOW values are appropriate for the histogram.

4. Press [2nd] [STAT PLOT] ENTER.

5. Press ENTER to turn the plot on, if necessary.

6. Move cursor to the histogram symbol, and press ENTER, if necessary.

7. Make sure Xlist is L1.

8. Make sure Freq is L2.

9. Press GRAPH to display the histogram.

Input

Input

Output



Example TI2–2

Plot a histogram for the data from Examples 2–4 and 2–5.

Class boundaries Midpoints Frequency

99.5–104.5 102 2
104.5–109.5 107 8
109.5–114.5 112 18
114.5–119.5 117 13
119.5–124.5 122 7
124.5–129.5 127 1
129.5–134.5 132 1

To graph a frequency polygon from grouped data, follow the same steps as for the histogram
except change the graph type from histogram (third graph) to a line graph (second graph).

To graph an ogive from grouped data, modify the procedure for the histogram as follows:

1. Enter the upper class boundaries into L1.

2. Enter the cumulative frequencies into L2.

3. Change the graph type from histogram (third graph) to line (second graph).

4. Change the Ymax from the WINDOW menu to the sample size.

OutputInputInput
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Output

Output

Excel
Step by Step

Constructing a Histogram
1. Press [Ctrl]-N for a new worksheet.

2. Enter the data from Examples 2–2 and 2–4 in column A, one number per cell.

3. Select Tools>Data Analysis.

4. In Data Analysis, select Histogram and click the [OK] button.

5. In the Histogram dialog box, type A1:A50 as the Input Range.

6. Select New Worksheet Ply and Chart Output. Click [OK].

Excel presents both a table and a chart on the new worksheet ply. It decides “bins” for the
histogram itself (here it picked a bin size of 7 units), but you can also define your own bin
range on the data worksheet.



The vertical bars on the histogram can be made contiguous by right-clicking on one of the bars
and selecting Format Data Series. Select the Options tab, then enter 0 in the Gap Width box.
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2–4 Other Types of Graphs
In addition to the histogram, the frequency polygon, and the ogive, several other types of
graphs are often used in statistics. They are the Pareto chart, the time series graph, and
the pie graph. Figure 2–9 shows an example of each type of graph.

Figure 2–9
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